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Wir lieben Tiere.

Lesegerdt Halo

Bedienungsanleitung
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Geratebeschreibung

Das Lesegerat Halo kombiniert Leistungsstarke mit einem kompakten, ergonomischen Design. Es wird im
praktischen, gepolsterten Hartschalenkoffer geliefert. Durch die Bedienung mit nur einem Knopf ist es duBerst
komfortabel. Wegen der grollen Antenne wird ein Leseabstand von bis zu 10cm erreicht. Dabei beherrscht das
Gerat die Lesestandards FDX-B, FDX-A (FECAVA) und Biotherm Microchip. Beim Lesen wird die Chipnummer
gespeichert und kann bequem am PC ausgelesen werden. Dazu wird es mit Hilfe des mitgelieferten Kabels mit
dem PC verbunden. Mit diesem Kabel wird auch direkt der Akku des Gerates an einer beliebigen USB-
Schnittstelle aufgeladen. Eine Akkuladung ist fiir ca. 1000 Lesevorgange ausreichend. Durch die kostenlose
Software kann auch liberprift werden, ob ein Tier bei den Datenbanken "Scanner Angel", "PetLog" oder
"DogLost" als vermisst gemeldet wurde.

USB-
Schnittstelle

Antenne

LC-Display
Bedientaste

Lieferumfang

=  Lesegerat Halo

= Mini-USB-Kabel

=  Gepolsterter Hartschalenkoffer
=  Kurzanleitung

Optional kann folgendes Zubehor bestellt werden:
=  Datentrdger mit Software

=  Gedruckte ausfihrliche Bedienungsanleitung
= USB-Steckdosenladeadapter

Technische Details

Entspricht dem Standard ISO 11784

Mafe: 135mm Durchmesser, 33mm Tiefe

Gewicht: 170g

Stromversorgung: 7,4V 1800mA Lithium-Polymer-Akku

2 x 12mm FDX-A (10-stellige Nummer) Chipleseabstand: bis zu 10cm

2 x 12mm FDX-B (15-stellige Nummer) Chipleseabstand: bis zu 10cm

Liest auch Biotherm Transponder

USB-Anschluss

Zweizeiliges, gut lesbares LC-Display

Speichert die letzten 2730 Nummern im Geratespeicher, der am PC ausgelesen werden kann




Transponder einlesen
Schalten Sie das Gerat mit einem Druck auf die Bedientaste ein. Das Gerat piept und zeigt auf dem

Display
Halo Scanner

Scanning

an. Das Gerat befindet sich jetzt bereits im Lesemodus. Bringen Sie nun die Antenne in die Nahe des
Transponders und wird er erkannt, piept der Leser zwei Mal und zeigt die Transpondernummer auf
dem Display an. Nach etwa 40 Sekunden schaltet sich das Gerat selbstandig ab. Mdchten Sie weitere
Transponder einlesen, wiederholen Sie den Vorgang. Auch wahrend die Nummer noch angezeigt wird,
kann ein erneuter Lesevorgang mit einem Druck auf die Taste aktiviert werden.

Wird nach ca. 20 Sekunden kein Chip erkannt, zeigt das Gerat

No Tag Found

an und schaltet sich nach 5 Sekunden aus.

Auslesen des Speichers am PC

= Systemvoraussetzungen

PC mit Windows ab Version 98
Mac und Linux werden leider nicht unterstitzt.

= Softwareinstallation

Damit der Computer mit dem Lesegerdt kommunizieren kann, muss es zunachst auf dem PC einmalig
eingerichtet werden. Dazu ist es notwendig die Treiber und die Lesesoftware zu installieren. Diese
befinden sich auf www.chiphandel.de = Downloads oder auf dem optional mitgelieferten Datentrager.

Flihren Sie die Datei ,,setup.exe” mittels Doppelklick aus. Bestatigen Sie eventuelle Sicherheitsabfragen
Ihres Systems. Nun gelangen sie in das Installationsmeni. Bestéatigen Sie die Dialoge, wie auf den Bildern
gezeigt.

i5! Setup - Scanner Angel — X

Welcome to the Scanner Angel
Setup Wizard
This will install Scanner Angel version 2.0 on your computer.

It is recommended that you dose all other applications before
continuing.

Click Mext to continue, or Cancel to exit Setup.
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ﬁ! Setup - Scanner Angel —

Select Destination Location
Where should Scanner Angel be installed?

Setup will install Scanner Angel into the following folder,

To continue, dick Mext. If you would like to select a different folder, dick Browse.

Browse, ..

Hier kann optional ein anderer
Speicherort angegeben werden.

At least 4,8 MB of free disk space is reguired.

ﬁE}' Setup - Scanner Angel —

Information
Please read the following important information before continuing.

When you are ready to continue with Setup, dick Next.

=ND-USER LICENSE AGREEMENT FOR Halo Scanner and Scanner Angel ~
IMPORTANT PLEASE READ THE TERMS AND CONDITIONS OF THIS LICENSE
AGREEMENT CAREFULLY BEFORE COMNTINUING WITH THIS PROGRAM INSTALL:
Pet Accessory Waorkshop Ltd End-User License Agreement (EULAT) is a legal
agreement between you (gither an individual or a single entity) and Pet Accessory
Workshop Ltd, for the Pet Accessory Workshop Ltd software product(s) identified
above which may indude assodated software components, media, printed
materials, and “online” or electronic documentation ("SOFTWARE PRODUCT ™). By
installing, copying, or otherwise using the SOFTWARE PRODUCT, you agree to be
bound by the terms of this EULA. This license agreement represents the entire
agreement concerning the program between you and Pet Accessory Workshop
Ltd, {referred to as Ticenser”), and it supersedes any prior propos.
representation, or understanding between the parties. If you do njill agree to the
terms of this ELLA, do not install or use the SOFTWARE PRODUCT.

ot e i m— g—— AT c e P '

ﬁl Setup - Scanner Angel -

Select start Menu Folder
Where should Setup place the program's shortcuts?

|£| Setup will create the program's shortouts in the following Start Menu folder.
[ -]

To continue, dick Next. If you would like to select a different folder, dick Browse,

f>canner Angel Browse...




ﬁ?}' Setup - Scanner Angel —

Select Additional Tasks
Which additional tasks should be performed?

Select the additional tasks you would like Setup to perform while installing Scanner
Angel, then did: Mext.

Additional icons:

[ create a desktop icon

1

Setzen Sie hier einen Haken, wenn
Sie eine Verknipfung auf dem
Desktop wiinschen.

< Back Cancel

ﬁ?}' Setup - Scanner Angel —

Ready to Install
Setup is now ready to begin installing Scanner Angel on your computer,

Click Install to continue with the installation, or did: Back if you want to review or
change any settings.

Destination location:
C:\Program Files (x86)\Scanner Angel

Start Menu folder:
Scanner Angel

< Back Instal Cancel

Installing
Please wait while Setup installs Scanner Angel on your computer,

Extracting files...
C:'\Program Files (x86)\scanner Angel\Scannerangel.exe

Cancel




Willkommen {

Mit diezem Assistenten konnen Sie Softwaretreiber
ingtallieren, die zum ordnungsgemalen Ausfihren einiger
Computergerate eforderich sind.

Klicken Sie auf "Weiter”, um den Vo ortzusetzen.

oW MicrocHIP

Zurick Weiter > Abbrechen

End User License Agreement

\ Sie missen dem folgenden Lizenzvertrag zustimmen, um die Installation
fortsetzen zu konnen. Verwenden Sie die Bildlaufleiste oder dricken Sie die
BILD-ABE-TASTE., um den gesamten Vertrag anzuzeigen.

MICROCHIP IS WILLING TO LICENSE THE ACCOMPANYING A
SOFTWARE AND DOCUMENTATION TO YOU QNLY ON THE
CONDITION THAT YOU ACCEPT ALL OF THE FOLLOWING TERMS.
TO ACCEPT THE TERMS OF THIS LICENSE, CLICK "I ACCEPT"

D PROCEED WITH THE DOWMNLOAD OR INSTALL. IF YOU DO

T ACCEPT THESE LICENSE TERMS, CLICK " DQ NOT

CEPT," AND DO NOT DOWNLOAD OR INSTALL THIS

WARE.

(®) | accept Speichem unte Drucken
(O | do not accept

‘ < Zuniick Weiter = Abbrechen

Fertigstellen des Assistenten

Die Treiber wurden auf dem Computer installiert.

Sie konnen jetzt das Gerat an den Computer anschliefen. Falls Sie
Uber eine entsprechende Gebrauchsanweisung verflgen, sollten
Sie diese zuerst lesen.

Treibemame Statu

w" Microchip Technology, |...  Betricibereit

o
T
U
0
o
U
>3
A

Zurick Fertig stellen Abbrechen




i=! Halo Registration by

[
Thank you for your purchase and instalingthe SCJOMNNEfr
Halo Scanner.

angel
By clicking next you are confirming that you Bringing them home
have read and agreed to the terms and

conditions on the use of this software. A copy

of the term and conditions is included on the
CD.

To complete the installation and to register the
scanner for the warranty, please click 'Next'

Im folgenden Dialog kénnen Sie |hr Gerat optional registrieren. Fir die Funktionsweise des Gerates und
der Software ist eine Registrierung allerdings nicht erforderlich.

™

scdnner
Address Line 1: |:| an gel
Address Line 2: |:| Pringing thern home
Y
County:[ ]

Country:
Post Code: |Germany |

Phone Number:

Email Address:




Completing the Scanner Angel
Setup Wizard

Setup has finished installing Scanner Angel on your computer.
The application may be launched by selecting the installed
icons.

Click Finish to exit Setup.

= Bedienung der Software

= Auslesen der Nummern

Starten Sie die Software ,Scanner Angel“. Verbinden Sie das Lesegerat mit Hilfe des USB-Kabels mit dem
Computer. Wird das Gerat erkannt, erscheinen die Nummern sofort im Fenster:

=

File Edit Advanced Help

/'Scanned Chip Numbers | Missing N
(i kel | Sscanner

m 900096000040561 an gel

m900096000040561 Bringing them home
m900096000040561
m900096000040561
W 900096000040561
W 900096000040561
| W 900096000040561

Last Update: 10.08.07 11:05:42

Wird das Gerat nicht erkannt, trennen Sie die Verbindung zum PC und schlieRen Sie das Gerat dann
erneut an.

» Ubertragen der Nummern

Mochten Sie Nummern eine externe Anwendung kopieren, kdnnen Sie einzelne Nummern anwahlen
indem Sie das Kontrollkdstchen links neben den Nummern anklicken. Mdchten Sie stattdessen alle
Nummern auswahlen, klicken Sie auf Edit -> Select All. Mdchten Sie alle angewahlten wieder abwahlen
klicken Sie auf Edit -> Select None. Um Sie in den Zwischenspeicher zu kopieren, driicken Sie Strg + c
oder Edit -> Copy. Fligen Sie nun die Nummern in Ihre Anwendung per Strg + v ein.




[ﬁ Scanner Angel for Halo Scanner V2.0 — *
File = Edit Advanced Help
Copy Ctrl+C

win [ s N\ gscanner
_____________________________________________ ﬂge|

= Nummern als Datei speichern

[ﬁ Scanner Angel for Hale Scanner V2.0 — >
File Edit Advanced Help

Save

¢ Scanned C

Mochten Sie alle Nummern als *.txt-Datei abspeichern, klicken Sie auf File -> Save. Im Nachten Dialog
wahlen Sie bitte den Speicherort und den Dateinamen aus. Dort kénnen Sie die Datei wiederfinden.

= Geratespeicher l6schen

Mochten Sie den Nummernspeicher des Gerates I6schen, miissen Sie das Gerat zurlicksetzen. Klicken
Sie dazu auf Advanced -> Reset Scanner.

[‘E Scanner Angel for Halo Scanner V2.0 — >
File Edit Advanced Help
Keyboard Wedge

s\ scanner

angel

Bringing therm home

Durch die Bestatigung des folgenden Dialoges mit OK wird der Resetvorgang gestartet:

[
|
|
| ! Are you Sure you want to reset the scanner?
|
|

QK Abbrechen

L

Es erscheint folgender Dialog:
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Please unplug any attached scanners and then click OK and wait for 5 seconds
before plugging the scanner back in.

0K

Trennen Sie nun lhr Gerat vom PC, bestatigen Sie den Dialog mit einem Klick auf OK. Warten Sie nun
mindestens 5 Sekunden und stellen Sie die Verbindung mit dem PC wieder her. Wird der Scanner
erkannt, wird die Software des Gerates zurlickgesetzt.

An der Prozentanzeige kénnen Sie sehen, wie der Fortschritt des Vorganges ist.

Progress: Resetting Scanner 20%
Last Update: 10.08.0/ 11:05:42

Auf dem Display des Lesegerates wird angezeigt:

Updating
Do Not unplug

Der Scanner darf wéiihrend des gesamten Vorgangs nicht vom PC getrennt werden.

Laden der Batterie

Der Leser wird durch einen Akku mit Strom versorgt. Dieser Akku ist so konzipiert, dass ca. 1000
Lesevorgange mit einer Akkuladung maoglich sind. Er kann durch einen USB-Anschluss aufgeladen
werden. Die Lebensdauer der Batterie hangt nicht nur von der Verwendung, sondern auch von der
Umgebung, in der der Leser gelagert wird, ab.

Eine Anzeige an der rechten Seite des Displays zeigt den Ladezustand des Akkus.

Sicherheitshinweise

Lagern Sie das Gerat an einem trockenen Ort. Die Lagerungstemperatur darf -10°C bis 60°C nicht unter- bzw.
Uberschreiten. Die Betriebstemperatur liegt zwischen -5°C und 40°C.

Halten Sie den Leser von Kindern und Tieren fern.
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Garantie, Support, Kontakt

Die Garantiedauer betragt 2 Jahre. Mdchten Sie einen Garantiefall melden oder benétigen Sie technische Hilfe
beim Verwenden des Gerates, wenden Sie sich bitte an:

Wir lieben Tiere.

chiphandel.de
Tierkennzeichnung
Inh. Daniel Rebotzke

Lindenstr. 12 A

OT Cobbel

D-39517 Tangerhiitte

Tel.: +49 (03935) 212044
Mobil: +49 (0174) 798 44 88
FAX: +49 (03935) 955 99 50

info@chiphandel.de

www.chiphandel.de

© Copyright by chiphandel.de
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